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Introduction

Welcome 10 MacGlobe

MacGlobe brings a world of information to your Macintosh. With the collection of
international maps in MacGlobe, you can locate the most densely populated
countries, least developed nations, or members ofNATO without running to the
library or leafing through an atlas. In addition, the extensive database in MacGlobe
allows you to explore a country or compare several countries on maps or charts.

MacGlobe worles much like a printed almanac or atlas but offers two distinct
advantages over printed resources. First, MacGlobe enables you to modify maps by
painting countries and regions, displaying cities, or adding map features. Second,
MacGlobe combines maps, charts, and tables to offer a single source of international
data.

Currenl Evenls and MacGlobe 1.3.0

It has been achallenge for MacGlobe to keep up with current political events around
the world. MacGlobe now includes updated data on 208 countries. The following
eighteen countries were added in this version of the software:

Armenia Kyrgyzstan Turkmenistan
Azerbaijan Latvia Ukraine
Belarus Lithuania Uzbekistan
Estonia Moldova Yugoslav Federation
Georgia Russia Croatia
Kazakhstan Tajikistan Slovenia

Data for this edition was gathered until March 15, 1992. While the break-up of the
Soviet Union seems rather final at this time, the situation in Yugoslavia is still
uncertain. Observers are uncertain as to the near future of the region. As of March
15, 1992, a cease-frre is in effect and UN peace-keeping forces have been deployed.

MacGlobe 1.3.0 offers separate profiles on Croatia and Slovenia, which are in the
process of seeking worldwide recognition. They have attained the recognition of
most European countries.

"Yugoslav Federation" is MacGlobe's country name for the entity composed of
those republics that were still apart ofYugoslavia on March 15, 1992. These
republics differ from Croatia and Slovenia in that they are still under federal control,
although some may soon claim and/or achieve independence.



North America
South America
CentralAmerica
Middle East
Southeast Asia

The following fonner countries have been kept in MacGlobe's database to enable
users to compare data and maps with the new countries:

East Gennany West Gennany
USSR Yugoslavia

You can view fonner countries on Country Maps, Country Reports, and Comparison
Charts. USSR (foOller) and Yugoslavia (foOller) can also be viewed as a group of
several new countries on Regional Maps and through most Change... dialog boxes.

Although some infonnation was still missing March 15, 1992, a considerable effort
was made to gather data on the new countries. We believe users will find that
MacGlobe 1.3.0 constitutes a unique, current, and comprehensive treatment ofthe
recent changes in Eastern Europe and the fonner USSR.

The flags shown for the fonner USSR republics are those displayed outside the New
York City United Nations headquarters on March 4, 1992. MacGlobe's
representations are based on descriptions from the UN Dag Harnmarskjold Library.

Denominations, classifications, and boundaries in this program do not reflect any
judgments or endorsements regarding the legal status of territories on the part of
Bmderbund Software, Inc.

Maps Included in MacGlobe

Regional Maps:
Entire World
Africa
Asia
Australia and Oceania
Europe

Country Maps:
For 208 countries, including those ofthe fonner Soviet Union, East Gennany, West
Gennany, and Yugoslavia.

Groups:
ALADI - Latin American Integrated Association
Arab League
ASEAN - Association of Southeast Asian Nations
CARICOM - Caribbean Community & Common Market
CIS - Commonwealth of Independent States
CMEA (foOller) - Council for Mutual Economic Assistance
Commonwealth ofNations (British)
Developing Countries
EEC - European Economic Community
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Age Distribution
Languages, Ethnic Groups, Religions
City Information
Resourees, Agrieulture, Industries
Culture & Tourism
Education
Mining and Quarrying
Manufaetured Goods

Islamie Conferenee
Least Developed Countries
NATO - North Atlantic Treaty Organization
Non-Aligned Movement
OAS - Organization of American States
OAU - Organization of African Unity
OECD - Organization of Eeonornie Cooperation and Development
OPEC - Organization of Petroleum Exporting Countries
UN - United Nations
USSR (former)
Warsaw Paet (former)
Yugoslavia (former)

Statistics and Features Included in MacGlobe

Database Categorles:
Population
Gross National Product (GNP)
Health Statistics
ImportslExports
Governrnent
Histol)'
Energy
Agrieultural Produetion
Climate

Other Data:
Count!)' flags
National anthems
Telephone, telex, and ham radio eodes
TraveI, visa, and health requirements

Features:
Distanees and bearings between major eities or latitude/longitude points
Automatie eurreney eonversions
Time zones
Standard/metric toggle
Data export
Graphie export in PICT format
Printer output
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New Features in MacGlobe 1.3.0

In this version 01MacGlobe, we've added:

• Maps and data for eighteen newly emerged European countries
• New printer drivers
• Complete database update
• Time zones
• Currency conversions

Updates

Updates with the latest statistics and boundary changes are available periodically to
keep you in step with an ever-changing world. You will be informed ofthe
availability of updates once you have mailed in your registration card. Registration
also entitles you to special pricing on periodic updates and puts you on our mailing
list for future products.

The User's Guide

Learning how to use MacGlobe is a matter of understanding and navigating its
menus and dialog boxes. You can leam to use MacGlobe by going through menus,
selecting available options, and watching what happens. If you prefer hands-on
instruction, tbis user's guide provides practical examples and explains all the
features in MacGlobe.

lf you need instruction in Macintosh operations like pointing, clicking, dragging, and
selecting menu items, refer to your Macintosh Reference or System Software User's
Guide.

System Requirements

MacGlobe requires the following minimum Macintosh system:

• Mac Plus or later model computer
• at least I Mb RAM
• a hard disk
• Macintosh System 6.0.4 or later, including 7.0
• a single 800K disk drive (needed for installation)

MacGlobe supports all printers and other peripherals that are compatible with the
system described above.

4



Installation Instructions

1. Insert Disk 1 into your drive.

2. Double dick on the MacG10be InstaUer icon.

3. C1ick on the InstaU button to begin installation.

System 6 users:

4a. Click the Drive button to choose the desired drive (only necessary ifthe wrong
drive is selected). Click the InstaU button to load the application.

l=labMac I
o Adobe Illustrator Q: = labMac
<l\ flld\l~ l' Jedl,!fHI ·~dl

~ ~;;~;:':;::~~::'3~:iI :~:~:
o Data Desk ;n;

I nstall in a nelll folder Install

1'3m",". . Cancel

System 7users:

4b. Click the Desktop button to choose another drive (only necessary if the wrong
drive is selected). Click the InstaU button to load the application.

o Adobe Photoshop
o Aldus FreeHand 3.0
o Aldus PageMaker 4.2
o Assorted
o Grammar
o HyperCard

=labMac

Desktop

Nelll CJ )

Install in a nelll folder named: (

1~@~m~d~m~H~'!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!~I n
Cancel J

Install Jl

5. When prompted, insert Disk 2 into your drive.

6. Reinsert Disk 1 when prompted.

7. When the installation is complete, the message "Installation Completed
Successfully" will appear. Click on OK to exit.

If you do not receive tbis message, double check that your system meets
MacGlobe's system requirements. Ifso, begin the installation process again. Ifyou
are still unable to install MacGlobe, call (415) 382-4700 for technical support.
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Using MacGlobe

The database in MacGlobe includes the following:

Regional Maps show all countries in geographic regions like Europe or the Middle
East. You can paint countries and display selected cities.

Country Maps show cities, topography, and major features für individual countries.

Thematic Maps compare statistics from selected countries on regional or world
maps.

Comparison Charts are bar charts that compare data from either the top or bottom
ten countries for any statistic. You can also compare these ten countries to any
selected country.

Country Reports display data for individual countries (for example, health statistics
for Canada). MacGlobe presents data on bar charts and tables.

Utilities offers four selections:

Country Flags includes illustrations of 208 country flags.
Distances is a view ofthe world map that lets you calculate point-to-point
distances between two cities.
Time Zones shows you the local time in the major cities ofall 208 countries in
the MacGlobe database.
Currency Conversions lets you convert any amount of one currency to that of
another.

Regional Maps

Regional Maps display all the countries located in a region. There are ten Regional
Maps: The Entire World and nine localized regions.

To use Regional Maps:

1. Choose Regional Maps from the View menu.
The Entire World Regional Map will appear.
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Re ionol Mops - [ntire Wortd

... .."

AUSTRAL.. Q Q

The Entire World Regional Map

2. Move the cursor over the map without clicking on the mouse button.
As the cursor crosses over a country or body ofwater, the name appears in the
status box in the lower left-hand corner ofthe window.

3. To view a Country Map directly from a Regional Map, double-click on a
country.
A Country Map will appear for the country on which you double-clicked.

A paint palette and Paint pop-up menu appear at the top of all Regional Maps.
On black and white monitors, the paint palette offers a choice of fifteen patterns. On
color monitors, the paint palette offers fifteen colors. You can paint any country,
region, or country group included in MacGlobe.

To paint a country:

1. Select any pattern or color in the paint palette.
The pattern or color you click on will be highlighted.

2. Choose Countries... from the Paint pop-up menu.
The Paint Countries dialog box will appear.
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Paint Countries ...

Kampuchea (Cambodia) ~
./Kazal<hstan

Kenya
Kiribati
Korea, North

Selection: 1 of 208 Countries

RII ( None

n Paint ~

( Cancel 1
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The Paint Countries dialog box

3. Seleet any number of eountries to paint by elieking on their names.
To quickly scroll to the country you want, type the first few letters of its name.

4. Cliek on the Paint button.
The countries you select will be painted.

Pa;nt .... 1 I I I

KAZAKHSTAN

Painting a country

5. To paint all the eountries on tbe map, select All Countries on Map from tbe
Paint pop-up menu.
This paints all the countries with the selected color or pattern.

6. To paint an entire region, seleet Region from the Paint pop-up menu.
Then select a region from the submenu that appears.

7. Ifyou want to clear all painted eountries on tbe map, ehoose C1ear from
tbe Edit menu.



To paint an entire group ofcountries:

1. Seleet Group... from the Paint pop-up menu.
The Paint Groups dialog box appears.

( Cancel l n OK B

Select Groups ...

ALAO I - Latin America Integration Association
Arab League
ASEAN - Association of Southeast Asian Nations
CAAICOM - Caribbean Community ß' Common Market

.,.;CIS - Commonwealth of Independent States
CMEA (former) - Council for Mutual Economic Assistance
Commonwealth of Nations - British
Deueloping Countries
HC - European Economic Community
Islamic Conference

The Paint Groups dialog box

2. Seleet any number of groups to paint by elieking on their names.
To select groups that are not adjacent on the list, hold down the shift or
cornrnand key and dick on their names. To select groups that are adjacent,
dick on one countty and drag up or down.

3. Cliek on OK.
The countty groups you selected will be painted.

To paint countries directlyon the Regional Map:

Select a color or pattern from the paint palette. Then dick on the countries you want
painted. Use the status box in the lower left-hand corner ofthe window to help you
identify the correct countty.

To change Regional Maps and choose cities to display, you need to use the Change
Regional Maps dialog box. For example, you rnight want to display the cities of
Amman, Jordan and Damascus, Syria on a map of the Middle East.

Follow these steps:

1. Choose Change... from the Edit menu.
The Change Regional Maps dialog box will appear.
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Change Regional Maps .

Map:1 Entire World I
Sholll Cities on Map

Ralborg, DENMARK
Aalst, BELG IUM

./Aarhus, DENMRRK

./Abadan, IRAN

./Aba, NIGERIA

K OK 1)

( Cancel )

Selection:

All

80f 1785 Cities

( None

o
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The Change Regional Maps dialog box

2. Choose MitJdle East from the Map pop-up menu.

3. Click on None to deselect an eitles that are a1ready selected.
If no cities are selected, the None button will be inactive.

4. Select AMMAN, Jordan and DAMASCUS, Syria from the Citles list.
Use the scroll bar to find the cities or type the first three letters of their narnes to
automatically scroll the cities list. A check mark will appear next to the
selections. Note that capital cities are shown in all capitalletters on the Cities
list.

5. Click on OK.
The Regional Map will appear with the selected cities marked.

:0

Middle East Regional Map showing Amman and Damascus



Somefacts about the Change Regional Maps dialog box:

You ean seleet as many eities as you want !Tom the Cities list. T0 seleet a single
eity, cliek on it. To seleet several adjaeent eities, click on one eity and drag through
eities listed above or below it. To seleet several eities that are not next to eaeh other,
cliek on them one by one. All seleetions ean be deseleeted by clieking on them. To
quiekly seroll to the eity you want, type the fIrst few letters ofthe city's name.

Ifyou ehoose one or two eities to display, MaeGlobe will indieate them with a
square and a label. If you ehoose three or more eities, MaeGlobe will only mark
them with a square. To identify eities, plaee the eursor on the eity's loeation. The
eity name will appear in the status box.

The Selection counter displays the number of eities seleeted on the Cities list.

Cliek on the All button to seleet all the eities that appear on the Cities list.

Cliek on the None button to deseleet all the seleetions made on the Cities list.

Note that when you displayaregional map other than the Entire World, a Paint pop­
up menu seleetion ehanges. Instead ofRegion (where you eould seleet a region to
paint from a submenu), you ean now seleet All Countries in Region. This option
paints all the eountries in the region on the displayed Regional Map.

Country Maps

Country Maps are maps of individual eountries. There are four types of Country
Maps.

Base Map - includes basie map, eountry flag, national anthem, population and area

Cities Map - map that displays major eities

Elevation Map - topographical map showing elevation above sea level

Features Map - map showing major features (e.g. volcanoes, tourist sites, mountain
ranges, civers, lakes, deserts, ete.)

To use Country Maps:

1. Choose Country Maps from the View menu.
A Country Map will appear.
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YUOOSLAlJ FEOERAT IOri

Oase Map ... 1

Population

17 I Mi 11 ion

Ar-eo (sq MI)

69,118

Hej Slavenl
(Oh, Slovs)

( Play )

12

YUGOSlAY HOERATla. 0

The Yugoslav Federation Base Map

2. To bear tbe eountry's national antbem, dick on tbe Play button.
Ifyou'd like to stop the music before the end ofthe anthem, dick on the Quiet
button.

3. Use tbe vertieal seroU bar to see otber open Country Maps.
Click on the up or down arrows or drag the scroll box up or down. As you drag
the scroll box, the names of the countries appear in the status box.

4. Use tbe Map-type pop-up menu to see tbe Cities, Elevation, or Features
Map for tbe same country'
This is located in the upper right-hand part ofthe window.

5. To view a Country Report from a Country Map, double-dick on tbe
Country Map window.
A Country Report will open for the Country Map on which you dicked.

The Change Country Maps dialog box lets you open Country Maps for selected
countries or for all countries in aselected group (like Europe or NATO). Suppose
you are interested in viewing maps of only South American countries.

Follow these steps:

1. Cboose Change... from tbe Edit menu.
The Change Country Maps dialog box will appear.



Change Country Maps ...

Count ries ~ I
AFGHANISTAN
ALUANIA
ALGERIA
AMERICAN SAMOA
ANDORRA

Selection: 11 of 208 Countries

All ( None

K OK )

( Cancel )

The Change Country Maps dialog box

2. Click on None to deselect an countries that may be already selected.
If no cities are selected, the None button will be inactive.

3. Choose Region, South America from the Countries pop-up menu.
Check marks appear on the Countries list next to the South American eountries.

4. Click on OK.
A Country Map of Argentina (the fIrst country in this group in alphabetical
order) will appear.

MacGlobe has opened the Country Maps of every South American country in
alphabeticalorder. Browse through the Country Maps using the vertical seroll bar.
Use the Map Type pop-up menu under the country's name to look at the Cities,
Elevation, and Features Maps.

Some facts about the Change Country Mops dialog box:

The Countries pop-up menu lists groups of regions and country groups. Choose
the region or group that contains the Country Maps you want to display. Check
marks will appear next to those countries on the Countries list. This is an easy way
to select all the countries in a region or country group.

You ean also select any number of individual Country Maps directly from the
Country Maps list. To select several adjacent countries, dick on one country and
drag through countries listed above or below it. To seleet several countries that are
not next to each other, dick on them one by one. All seleetions can be deselected by
dicking on them. T0 quickly serail to the eountry you want, type the fIrst three
letters ofthe country's name.

The Selection counter beneath the Country Maps list displays the number of
Country Maps you selected.

Click on the AU button to seleet all the countries in the database.

Click on the None button to deselect all the selections on the Country Maps list.
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Thematic Maps

Thematie Maps eompare statisties from seleeted eountries on regional maps.

To use Thematic Maps:

1. Cboose Thematic Maps from tbe View menu.
A Thematie Map will open.

Themotic Mops

) .

POPULATION 1992 1°
IL-----r===~~~~;;;;;;;;:;~=:=======;____

• Above 200,000

g 12,000-200,000

~ 800-'2,000

,
;~ "'~;i.

AUSTRALlA: 17 .547 <>'
Thematic Map 01world populations

2. Use tbe Map legend to compare countries.
A color or pattern is assigned to eaeh range of statisties.

3. To see precise statistics for tbe countries, move tbe cursor over tbe map
witbout clicking.
The name of the eountry and its preeise statistie appear in the status box.

4. Browse tbrougb tbe open Tbematic Maps using tbe borizontal scroU bar.
Cliek on the left or right arrows or drag the serail box to the left or right. As
you drag the serall box, the titles of the Thematie Maps appear in the status box.

The Change Thematie Maps dialog box allows you to open Thematie Maps for a
different region or a different eategory of statisties. Suppose you want to see a
Thematie Map that eompares the number of elementary sehools in Southeast Asian
eountries.

Follow these steps:

1. Cboose Change... from tbe Edit menu.
The Change Thematie Maps dialog box will appear.

14



Change Thematic Maps ... ( lOK
Map:1 [nUre World ·1

.............. ...................................... ...................... ............ ( Cancel )
category:! Demographies ·1

Population 1900

i.,.1Population 1991
Population 1992

.,.IPopulation 1993

.,.IPopulation 2000 -0
Selection: 5 of 108 t10ps

( All ) ( list ) ( None )

The Change Thematlc Maps dialog box

2. Choose Southeast Asia from the Map pop-up menu.

3. Choose Primary Education from the Category pop-up menu.
A list of elernentary education statistics will appear on the Statistics list.

4. Click on None to deselect statistics that may be already selected.
If no statistics were previously selected, the None button will be inactive.

5. Select Schools from the Statistics list.
A check mark will appear next to the selection.

6. Click on OK.
Each country gets filled with a color or pattern corresponding to the legend.

Thematir Maps

11 ---lilu,_ NUMBER OF PRIMARV SCHOOLS .

• Above 80,000

11 5 ,200-80,000

~ 320-5,200

[TI] B~low 320

D'i/A

PAPUA HEV GUINEA: 2,461 Cl

Thematic Map 01Southeast Asian primary schools
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Somefacts about the Change Thematk Maps dialog box:

The Map pop-up menu allows you to choose a region on which MacGlobe will
display statistical data.

The Category pop-up menu lists statistical categories. Select the category that
contains the statistic(s) that will serve as the basis of comparison. All statistics from
the selected category will appear on the Statistics list.

You can select any number of statistics from the Statistics Iist. To select a single
statistic, click on it. T0 select several statistics, click on one statistic and drag
through statistics listed above or below it. To select several statistics that are not
next to each other, click on them one by one. All selections can be deselected by
clicking on them.

The Selection counter displays the number ofThematic Maps that you selected.

Click on the All button to select all statistics regardless of category.

Click on the List button to select all statistics from the category selected on the
Category pop-up menu.

Click on the None button to deselect all selections made on the Statistics list
regardless of category.

Comparison Charts

Comparison Charts are bar charts that compare data from up to eleven countries.
MacGlobe will also deterrnine the "top" or "bottom" ten countries in terms of
statistics you select. You can also choose an eleventh country to compare to these
ten countries.

To use Comparison Charts:

1. Cboose Comparison Charts from tbe View menu.
A Comparison Chart will open.
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Comparison Charts

POPULATION 1992
( in thoUSQ'lds)

CHIHA 1,109,911

I ND I A 882,813

USSR (FORMER) 295,099

USA 254,522

INomlES IR 197,044

BRAZIL .. 158,152

RUSSIA nnnmrrrn 148,418

JAPAN t=J 124,:l13

PAKISTAN IJJB 120,427

BArlGLADESH ]]I] 119,283

{)-

Popul.lltion 1992 <> ~!I <> Q]

Comparison Chart ofworld populations

2. Browse through the open Comparison Charts using the horizontal scroll
bar.
Click on the left or right arrows or drag the scroll box to the left or right. As
you drag the scroll box, the names of the Comparison Charts appear in the
status box.

Tbe Change Comparison Charts dialog box alIows you to open selected Comparison
Charts. Suppose you want to open a Comparison Chart that shows the ten countries
that are expected to have the lowest population in the year 2000.

Follow these steps:

1. Choose Change... from the Edit menu.
The Change Comparison Charts dialog box will appear.

Change Comparison Charts ...

Top 10 + Selection ... I
[ Cancel 1 n OK 1)

Countries ... I
RFGHRNISTRN
RLORNIR
RLGERIR
AMERICAN SAMOA
ANOORRA

Category:1 Coal ... I
./Reserues
./Production

Consumption
Consumption per Capita

Selec:tion: 4 of 208 Count'''les Selec:tlon. 100 of 108 Charts

All [ None 1 All 1 [ list 1 (None 1

Change Comparison Charts dialog box
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2. Choose Bottom 10 Countries from the Chart pop-up menu.
Note the Countries list is inactive. This is because with this selection
MacGlobe detennines which countries to compare.

3. Cück on None undemeath the Statistics list to deselect any statistics that
may be already selected.
If no statistics are already selected, the None button will be dim.

4. Select Demographics from the Category pop-up menu (if it's not already
selected).
A list of demographics statistics will appear on the Statistics list.

5. Select Population 2000 from the Statistics list.
A check mark will appear next to the selection.

6. Click on OK.
The chart will open.

Compörison Charts

POPULATION 2000
( In thous:ands:)

Af1ER IeAN SAMOA liiifT;"""':4" ,

SAlrn KITTS tlEUIS .~.. .....'i

CAVMArl ISlANDS

MOtiACO

LI ECHTENSTE I N

SHN I1ARlfiO "
ulRG1I1 ISLANOS tJt...

TWfLU 111
lftJRU 1 10

FALKlAttJ ISlfV't)S 012:.:.:

13

y; 24

30

",

33

39

41
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Peput.tion 2000 r...'ST ~

Comparison Chart showing the ten countries with the lowest
projected population in the year 2000

Some facts Mout the Change Comparison Charts dialog box:

The Chart pop-up menu lists the following items:

Top 10 Countries
Charts the 10 countries with the highest ranking for a selected statistic.

Bottom 10 Countries
Charts the 10 countries with the lowest ranking for a selected statistic.

Up To 11 Selections
Charts up to eleven countries selected from the Countries list.

Top 10 + Selection



Lets you compare a country ofyour choosing to the ten countries with the highest
ranking for a selected statistic.

Bot/om 10 +Selection
Lets you compare a country ofyour choosing to the ten countries with the lowest
ranking for aselected statistic.

The Countries pop-up menu lists regions and country groups. Choose a region
from the submenu or a group from the dialog box that appears. MacGlobe will
automatically se1ect your choices on the Countries list.

The Countries list indudes all the countries in the MacGlobe database. You can
select any number of countries direct1y from the Countries list. To se1ect a single
country, dick on it. To se1ect several countries, dick on one country and drag
through countries listed above or below it. T0 select several countries that are not
next to each other, dick on them one by one.

MacGlobe will show the se1ected countries on Comparison Charts for selected
statistics. Comparison Charts can show up to 11 countries.

The Category pop-up menu lists categories of statistics. Select the category that
contains the statistics in which you are interested. Statistics in this category will
appear on the Statistics list.

The Statistics Iist indudes all the statistics in the category selected from the
Category pop-up menu. To select a single statistic, dick on it. To se1ect several
statistics, dick on one statistic and drag through statistics listed above or be10w it.
To se1ect several statistics that are not next to each other, dick on them one by one.
All se1ections can be deselected by dicking on them.

There are two Selection counters in the Change Comparison Charts dialog box.
Each counter displays the number of items you selected on the list above it.

The All buttons se1ect all countries or statistics in the MacGlobe database. To se1ect
all the countries in the database, dick on the All button undemeath the countries list.
To select all the statistics in MacGlobe's database, dick on the All button
underneath the statistics list.

Click on the List button to se1ect all statistics from the selected statistical category.

There are two None buttons in the Change Comparison Charts dialog box. Click on
the None button underneath the Countries list to deselect all selected countries.
Click on the None button underneath the Statistics list to deselect all se1ected
statistics.
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Country Reports

Country Reports present demographie, economic, educational, health, and other
statistics for every country in the MacGlobe database. MacGlobe includes up to
seventeen Country Reports for each country in its database.

To use Country Reports

1. Choose Country Reports from the View menu.
A Country Report will appear.

2. Use the horizontal seroU bar to move through different Country Reports
for the same eountry.
Click on the left or right arrows or drag the scroll box to the left or right. As
you drag the scroll box, the names of the Country Reports appear in the status
box.

3. Use the vertieal seroU bar to see Country Reports for different eountries.
Click on the up or down arrows or drag the scroll box up or down. As you drag
the scroll box, the names of the countries appear in the status box.

The Change Country Reports dialog box allows you to select which countries and
reports you want. Suppose you are interested in an import/export report for Japan.

Follow these steps:

1. Choose Change... from the Edit menu.
The Change Country Reports dialog box will appear.

Chllnge Country Reports ...

Countries ... I
[clInce' )

Report:

t OK B

RFGHANISTAN
"LRANIA
ALGERIA

....RMERICAN SRMOA

.... RNDORRA

Popullltion ~

.... Age Distribution b

....Gross NlItionlll Product (GNP) WH:
LlIngullges, Ethnic Groups, Religior mm

....Hellith Stlltistics 0.
Selection: 3 of 208 Countries~

All [ None 1
Selection: 3 of 17 Reports

All [ None

Change Country Reports dialog box

2. Cliek on None to deselect any eountries that may be a1ready selected.
If no countries are selected, the None button will be dim.

3. Select Japan from the Countries list
Use the scroll bar to move the list to Japan or type the first few letters of the
country's name to scroll the list. A check mark will appear next to the
selection.
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4. Click on None to deselect reports that may be already selected.
If no reports are already selected, the None button will be dim.

5. Select ImportslExports from the Report list.
A check mark appears next to the selection.

6. Click on OK.
The report will open.

Country Reports
o

JAPAN

NOj or I lI,por \.$

Foodsluffs

Fish

I1achl~Y

Pelroleulll ProdlX:ls

ChQmlcols

Text.. I es

Nonferrous Metals

MetalOres

Lumber

Cool

• Bolanc:e cf Trade (1990) $53,580,000,000

JAPAN Q

MOJ or Export.

Vehlcles

Office EQUip-enl

Iren & Sleet

Chellllcols

SClent, f,e: Equlptlenl

Optic:al Equtptlent

TClpe Rec:ol'ders

Text, I~s

I\achlnery

Elec:lrOOlc.s

Sem I conc:loc: tors

The Japanese import/export report

Some facts about the Change Country Reports dialog box:

The Countries pop-up menu lists regions and country groups. Choose a region
from the submenu or a group from the dialog box that appears. MacGlobe will
automatically select your choices on the Countries list.

The Countries list indudes all the countries in the MacGlobe database. You can
also select any nurnber of countries directly from the Countries list. To select a
single country, dick on it. To select several countries that are not next to each other,
dick on them one by one. All selections can be deselected by dicking on them.

The Report list indudes all the reports in the MacGlobe database. Select the
report(s) to display for the country or countries selected.

To select areport, dick on it. To select several reports, dick on one report and drag
through reports that are above or below it on the list. To select several reports that
are not next to one another on the list, dick on them one by one. You can open
selected reports for selected countries.

There are two Selection counters in the Change Country Reports dialog box. Each
counter displays the nurnber of items selected on the list above it.
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There are two All buttons in the Change Country Reports dialog box. Click on the
All button underneath the Countries list to select all the countries in MacGlobe.
Click on the All button underneath the Report list to select all the reports in the
database.

There are two None buttons in the Change Country Report dialog box. Use them to
deselect all the selections on the list above it.

Utilities

The Utilities Menu offers four features: Country Flags, Distances, Time Zones,
and Currency Conversions. There is also a selection called Options that allows
you to customize many MacGlobe view windows.

Country Flags

MacGlobe contains illustrations of every country's flag.

1. Cboose Country Flags from tbe Utilities menu.
The Country Flags view window will appear.

:0

SLOIJENI A

$OUTH AFR I CA

SR I LANKA

(Dunlr F1a s

SOLONON I SLANOS

SOUTH KOREA

SUDAN

SOMALIA

SPAIN

SUR!NAME

Country Flags view window

2. Click on tbe arrow at tbe bottom of tbe vertical scroU bar.
The next Country Flags window will appear.

Continue clicking on the vertical scroll bar to see all the country flags included in
MacGlobe.

22



Distances

Distances ailows you to calculate the point-to-point distance and hearing hetween
any two cities in MacGlobe. Suppose you wanted to find the distance from New
York to Moscow.

Follow these steps:

1. Choose Distances from the Utilities menu.
The Distances view window will appear.

2. Click on From....
The Distances dialog box wiil appear.

3. Select New forle, USA from the Cities Iist.
Scroil to New York, USA ortype the first few letters ofthe city's name.

From ...

New Kowloon, HONG KONG
New Plymouth, NEID ZERLRND

'/New York:, USR
Ngamaba-Mfilou, CONGO
Ngozi, BURUNDI

n OK ))

Distances dialog box

4. Click on OK.
The Distances view window will reappear. New York is now the From city.

5. Click on To....
The Distances dialog box will appear.

6. Select Moscow from the Cities Iist.
Scroil to Moscow, RUSSIA or type the first three letters ofthe selection to
automatically scroll the list.

7. Click on OK.
The Distances view window will reappear. MacGlohe has designated Moscow
as the To city. The point-to-point distance and bearing between the two cities
appears at the top right-hand section ofthe window.
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:0 Dis'tlntes

Distance: 4,664 miles

Bearing: 34.4"

Distances view window showing distance from New York to Moscow

Time Zooes

This utility shows you the local time in the major cities ofall 208 countries in the
MacGlobe database. You can also add your city and time zone if it is not listed
among the hundreds included in MacGlobe.

Follow these steps:

1. Choose Time Zones from the Utilities menu.
The Time Zones view window will appear.

:0
Lotel Time •..

Country ...

2:40pm

AFGHANISTAN

Time Zones
Pl"loen I )(, USA

OM1-7

24

City Name

KABlI..

Qondahcr

Heral

Mozcr-e-Shar i f

Jotatabad

Qond.lz

Boghlan

Me,-,maneh

Po I-e-Khollr i

Ghazn I

Time Zones view window

Time Zone

OM1+4 S

GMT+4.S

GH1+4.5

GMT+4.~

GMT+4.S

OMT+4. S

OM1+4.5

OMT+4.5

OM1+4.5

GMT+4. ~

Time

2: 10 am

2: 10 am

2: 10 am

2: 10 0'"

2: 10 0111

2:10 am

2: 10 am

2.10 am

2.10 am

2: 10 Clm



2. Click on Local Time....
A dialog box will appear. Use the scroll bar to find your city or type the first
few letters of its name to automatically scroll the list. Click on the city name.
Acheck mark will appear next to the city name, but will not remain visible (this
allows for custom user input).

Locol Time from GMT:

I -7.01 (-11.0 to +13.0) hours

The Locol Time Reference Name:

IphoeniH, USR

City References:

n OK D

[ Concel 1

Philadelphia, USR
Philipsburg, NETHERLRNDS RNTILLES
Phitsanulok, THR I LRND
PHNOM PENH, CRMBODIR
PhoeniH, USR

6MT-5
6MT-4
6MT+7
6MT+7
6MT-7

Loeal Time dialog box

3. Click on OK.
The Time Zones view window will appear again with the new reference city.

4. Click on Country.
The Select a Country... dialog box will appear. Scroll to a country or type the
first few letters ofthe country's name to automatically scroll the list. Select the
country by clicking on it.

S. Click on OlL
The Time Zones view window will appear again. MacGlobe will show the
major cities ofthe selected country along with their current times. For each
city, MacGlobe lists the number ofhours from GMT (Greenwich Mean Time).

You may want to reference Time Zones to a point other than a city listed in
MacGlobe.

Follow these steps:

1. Choose Time Zones from the Utilities menu.
The Time Zones view window will appear.

2. Click on Local Time....
A dialog box will appear.

3. Enter a time zone value in the Local Time from GMT box.
Enter a value from -11 to +13. If you don't know this value, find a city in
MacGlobe's database that you know is the same time zone and enter that value.
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4. Enter the name ofthe new city in the Local Time Reference Name box.
Press Tab to select this box or use your mouse.

5. Click on OK.
The Time Zones view window appears again with the new reference city.

Currency Conversions

This utility lets you automatically convert any amount of one country's currency to
that of another. Suppose you want to convert from US dollars to French francs.

Follow these steps:

1. Choose Cu"ency Conversions from the Utilities menu.
The Currency Conversion view window will appear.

~ [urrenC!-I Conuenion 0~

0
( Fromm) US dollar

USA
1 OO/US dollar

~ Freneh franc
FRANCE

S f>O/US doller

I 10~1 US dollor

times 5.60 Freneh frone/US dollor

equols 560.00 Freneh frone
0-

Curr~ ..ov C.fty.,,.sio. 101 IQ

Cu"ency COnVerSlOn Vlew wmdow

2. Click on From....
A Country/Currency dialog box will appear.

3. Click on the country/currency you want to convert from.
Scroll to USA! US dollar, or type the OOt three letters ofthe country's name to
automatica1ly scroll the list. Se1ect the country/currency by c1icking on it.

From ...

Country

...-USR
USSR (FORMER)
UZBEKISTRN
URNURTU
UENEZUElR

( Change Rate ...

Currency

US dollar
Rouble
Rouble
Uatu
Boliuar

[ Contel 1n OK B
per US$

1.00 g
100.00 mm
100.00 p!
111.88 ~
64.80 {}

Country/Currency dialog box

4. Click on OK.
The Currency Conversion view window will appear again.

5. Click on To•..•
A Country/Currency dialog box will appear.
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6. Click on the country/currency you want to convert to.
Scroll to France/franc, or type the first few letters ofthe country's name to
automatically scroll the list. Select the country/currency by clicking on it.

7. Click on OK.
The Currency Conversion view window will appear again.

8. Enter the number of units you would like to convert
Type in the number of dollars you want to convert to francs in the rectangular
box. The number ofFrench francs resulting from the conversion will
automatically appear at the bottom ofthe Currency conversion view window.

The Currency Conversion utility allows you to change exchange rates. The latest
exchange rates are published weekly in the business section of most newspapers.
All exchange rates are per US dollars. Suppose you want to update the dollar-ta­
franc exchange rate.

Follow these steps:

1. Choose Currency Conversions from the Utilities menu.
The Currency Conversion view window will appear.

2. Click on To....
The Country/Currency dialog box will appear.

3. Ifnot already selected, dick on the country/currency you want to convert •
Scroll to FrancelFrench franc, or type the first few letters ofthe country's name
to automatically scroll the list. Select the country/currency by clicking on it.

4. Click on Change Rate.
The Change Currency Exchange-Rate dialog box will appear.

Change Curreney EHe hange-Rate

Country: fRANCE
Curreney: freneh franc
OId ualue: 5.60 Feh. 1992

n OK D

( Caneel 1

New ualue: I 5.52 Sept. 1992

Change Currency Exchange Rate dialog box

5. Type in the new exchange rate.
Note the date and exchange rate from the last update appears above the new
entry.

6. Click on OK on this and the foUowing screen.
The new exchange rate will be retlected on the From... dialog box.
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Options

Cboose Options from tbe Utilities menu to open tbe Options... dialog box. Use tbis
dialog box to add or cbange map features. MacGlobe saves options and applies
tbem to all appropriate views until tbey are cbanged.

Uiew Options ...

RII Windows u Regional Maps

[8] Black 6' White Only [8] Show Country Borders

@ English Units
Show latitude

o and longitude Markso Metric Units

"" World Maps Center
,u Country Maps

[8] Show Riuers
@ 0 0 (Prime Meridian)

0 90 0 Westo Outline Only
0 90 0 East

Thematie Maps
o 180 0 (I nt'l Date Une)

@5 Ranges

n D09 Ranges [ Caneel 1 OK

Optzons dzalog box

Tbe All Windows section allows cbanges in options tbat affect all MacGlobe
windows. Select Black & White Only to display windows in black and wbite on a
color monitor. If your Macintosb lacks color capabilities, Black & White Only will
be turned on at all times. Ifyou bave a color monitor you should select tbis option
before printing to a black and wbite printer. English Units and Metric Units
buttons control wbether scales of distance will be shown in rniles or kilometers.

Tbe Country Maps section allows changes in options tbat affect all Country Maps.
Select Show Rivers to add rivers and lakes to base and cities maps. Select Ouiline
Only to draw only tbe borders of Country Maps, without background map colors.

Tbe Thematic Maps section of tbe Options dialog box allows changes in options
tbat affect all Tbematic Maps. Choose to display either 5 or 9 data ranges on
Tbematic Maps.

Tbe Regional Maps section of tbe Options dialog box allows changes in options
tbat affect all Regional Maps. Select Show Country Borders to display country
borders. Select Show Longitude and Latitude Marks to display degrees of
latitude and longitude on tbe lower and left edges ofRegional Maps.

The World Maps Center section oftbe Options dialog box allows changes in
options tbat affect world maps. Select the longitudinal degree tbat will serve as the
horizontal center of tbe world map.
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Printing and Exporting

You can print and copy all maps, charts, and text in MacGlobe. This allows you to
print hard copies of windows that interest you or paste them into graphics
applications. Please respect the copyright notice on copied and printed windows
and include it in your work. See the copyright statement at the beginning 01this
manual.

To print a window:

1. Choose Page Setup... from the File menu.
Select printer options as necessary.

2. Choose PrinL.. from the File menu.
MacGlobe will send the window to your printer.

You can paste MacGlobe windows into other graphics applications. This gives you
an excellent source of material for personal documents, reports, and presentations.

To paste MacGlobe windows into other programs:

1. Select Copy from the Edit menu.
The current MacGlobe window is copied to the Macintosh Clipboard.

2. Paste the window in an application that accepts PICT graphics.

MacGlobe uses the popular PICT file format. Most graphics and desktop publishing
applications, and some word processing applications will paste a MacGlobe window
from the Clipboard. Text can be placed in spreadsheet applications. You can also
paste graphics and text from MacGlobe into the Scrapbook desk accessory included
with your Macintosh system software.
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Glossary

ALADI - Latin American Integration Association:
Established in 1981 to create economic preferences for goods originating in
member states.

Arab League:
Formed in 1945 to promote economic, cultural, and political cooperation among
Arab states.

ASEAN - Association of Southeast Asian Nations:
Founded in 1967 to promote politica1 and economic cooperation among the
region's non-communist states.

CARlCOM - Caribbean Community and Common Market:
Organized in 1973 as a movement towards unity and economic integration in the
Caribbean.

CIS - Commonwealth of Independent States:
Formed in 1991 by eleven of the former Soviet repub1ics to foster cooperation on
defense, economy, and other issues.

CMEA - Council for Mutual Economic Assistance (former):
Founded in 1949 to assist the economic development ofCommunist member
states through the sharing of resources.

Commonwealth ofNations- originally the British Commonwealth:
Association of 47 self-goveming independent nations and dependencies loosely
joined by having been subject to rule by the old British Empire; the British
monarch is the symbolic head of the Commonwealth.

Developing Countries:
Group of countries which, according to the United Nations, have comparatively
weak economies. Per capita GNPs are less than $5000 per year.

EEC - European Economic Community:
One of three European communities established in 1957 to create a common
market among its members.

Islarnic Conference:
Organization to promote lslarnic solidarity and further cooperation among
member states in the economic, social, cultural, scientific, and political fields.

Least Developed Countries:
Subset ofDeveloping Countries. Group ofcountries which, according to the UN,
undergo litde or no economic growth. Per capita GNPs are less than $500 per
year.
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NATO - North Atlantic Treaty Organization:
Established in 1949 to provide a collective defense against arrned attacks through
the use of diplomatic channels, and mutually beneficial cooperation in economic,
scientific, and military areas.

Non-Aligned Movement:
Formed in 1961 to ensure the national independence and sovereignty of mostly
third world nations which are not in alliance with major power blocks.

OAS - Organization of American States:
Association of32 republics ofthe Americas (excluding Cuba) founded in 1948 to
promote solidarity among the American states as weil as to promote economic,
social, and cultural development within the hemisphere.

OAU - Organization of African Unity:
Association ofthe independent African states (excluding South Afiica) founded in
1963 to promote unity and eradicate colonialism in Afiica.

OECD - Organization for Economic Cooperation and Development:
Founded in 1961 to coordinate economic policies and encourage economic
growth and world trade.

OPEC - Organization of Petroleum Exporting Countries:
Founded in 1960 to coordinate and uniry petroleum policies of member countries
to stabilize international oil prices to eliminate harrnful and unnecessary price and
supply fluctuations.

UN - United Nations:
Organization ofthe world's states established in 1945 to maintain international
peace and security and to promote equal rights, self determination of peoples, and
humanitarian causes.

USSR (former):
A federation of fifteen republics proclairned in 1922 at the culrnination of the
Russian Revolution; dissolved December 25, 1991.

Warsaw Pact: (former):
Established in 1945 as a mutual defense agreement signed by the USSR and its
communist neighbors; dissolved April I, 1991.

Yugoslavia (former):
Comprised of Serbia, Croatia, Bosnia, Herzegovina, Macedonia, Slovenia, and
Montenegro. The Socialist federal repub1ic disintegrated in 1991 with the eruption
of civil war.
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Change Country Reports dialog box 21
Change Regional Maps dialog box 11
Change Thernatic Maps dialog box 16

Show Country Borders
Options 28

Show Longitude and Latitude Marks
Options 28

Show Rivers
Options 28

Statistics and Features in MacGlobe 3
Statistics list

Change Comparison Charts dialog box 19
Change Thematic Maps dialog box 16

System Requiremen~ 4

T

Thematic Maps 14-16
Change Thematic Maps dialog box 14-16
General usage 14
Map legend 14

Time Zones 24-26
General usage 24
Local Time 25
Referencing to a custom location 25
Select a Country... dialog box 25

Top 10 + Selection
Change ComparisonC~ dialog box 19

Top 10 Countries
Change Comparison Charts dialog box 18

U

Up To l1 Selections
Change Comparison Charts dialog box 18

Updates 4
Utilities 22-28

Country Flags 22
Currency Conversions 26--27
Distances 23-24
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